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IP Office Installation Punch-list 
 

Objective:  Punch-list for a basic IP Office installation.  This will not cover advanced 
programming such as Small Community Networking, remote IP Hard/Soft phones, etc… 
 
Note:  This document assumes you have completed the Avaya implementation 
workshop.  
 
Pre-install recommendations:  To ensure a smooth installation, verify that you 
have all required components.  Verify with Jenne Distributors, Inc. Technical Services 
that you have the most recent release of software. 
 
 
Install Procedure: 

 Install any internal daughter boards, i.e. Voice compression module, ATM-4, 
T1/PRI, modem. 

 Install rack mount kits (if applicable) on control unit and expansion modules. 
 Mount control unit and expansion modules. 
 For a stand alone install, power up your system.  If you are installing your 

system on a DHCP network, plug into your LAN prior to powering up the 
system.  Otherwise, the IP Office becomes a DHCP server itself. 

 Connect power lead to the power supply and connect power supply to the control 
unit and any expansion modules. 

 Install the Manager Application, Voicemail Pro application, and User applications 
onto the PC or PC’s you will be using. 

 After installation of the software, reboot your PC. 
 The default IP Address of the IP Office is 192.168.42.1, change the IP Address of 

your PC to 192.168.42.222. 
 Connect a standard Cat5 cable from your NIC to any LAN port on the IP Office 

Small Office or 406 V2.  If you have a 412, you will require an Ethernet cross-
over cable. 

 Launch the manager application, the login is “Administrator” the password is also 
“Administrator”. 

 

1IT 
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5 most wanted short codes for IP Office 
 

1. Transfer directly to voicemail 
Shortcode:         *55xxx  (where x’s are the length of your extension 
range) 
Telephone #:      #N 
Line/Group ID:  0 
Feature:              VoicemailCollect 
 
To use this SC, it is a 3-step process.  You have to press transfer and 
then either a programmed button or dial the SC, then enter the 
extension or press a DSS button on your phone then press transfer or 
hang up.  
 
**This shortcode will not work on Embedded voicemail. ** 
 

2. Call Park (used to park a call in a park slot or at an ext.) 
Shortcode:         *37*N# (N=park slot/ext. number – this is a default 
shortcode) 
Telephone #:      XXX (where x’s are the park slot or ext.) 
Line/Group ID:  0 
Feature:              Park Call 
 
**when parking at an extension, additional numbers are added to 
the park location.  If the call being parked is the first call parked 
at an extension, then the park location would be the extension 
followed by a “0”.  I.e. 2340, where 234 is the extension and “0” is 
the park slot.  If parking in a park slot, most people use park slot 
801-804.  The park slot can be a single to 5-digit slot number.  The 
system will not work with a park slot that begins with a “0”.  The 
park slot numbers begin with “1” and works upwards.   
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3. Unpark Call (used to pickup a call from a park slot or ext.) 

Shortcode:         *38*N# (N=park slot/ext. number – this is a default 
shortcode) 
Telephone #:      XXX (where x’s are the park slot or ext.) 
Line/Group ID:  0 
Feature:              RideCall 
 
**Most BP’s refer to unpark call as call pickup.  In the IP Office 
world, call pickup is used to answer a ringing call within a group 
(you must be a member of the group), from a designated ext., or 
any ringing phone in the system.  All 3 features are default 
shortcodes. 
 
 
 

4. Conference Meet Me  
Shortcode:         *67*N# (N=conference bridge nuber – this is a 
default shortcode) 
Telephone #:      N 
Line/Group ID:  0 
Feature:              ConferenceMeetMe 
 
**You can create multiples of this shortcode to designate specific 
conference bridges.  Replace the “N” in the shortcode with your 
bridge number, and the telephone number with you bridge 
number. 
 

 
 
5. I want to outpulse my caller-id on a PRI circuit 

Shortcode:         [9]1N; 
Telephone #:      1NSI800555E (where 800 is the area code and 555 
is the start of the telephone number and E is the user extension. 
Line/Group ID:  0 (Specify your line you make outbound calls on) 
Feature:              Dial 
 
**There are a couple caveats related to this short code.  The first 
is that the above-mentioned short code may not always work.  
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You may have to input a lower case “i” in front of the telephone 
number in the Incoming Call Route form in the Incoming 
Number field.  Also, the provider may not outpulse extension 
caller-id, they may just outpulse BTN (Billed Telephone Number) 
for the circuit or last 4 digits of the DID.   
 

 
 

Top Small Community Network short codes for IP 
Office 

 
 

1. I want to dial a hunt group across my small community network 
 Shortcode:         3XX (where 3XX is the hunt group across the 
network) 
Telephone #:      . (period) 
Line/Group ID:  25 (this is the IP trunk connecting sites) 
Feature:              Dial 
 
 

2. I don’t have copper lines in my system that is part of a small 
community network, how do I dial out of my home site? 
Shortcode:         [9]1N;  --  [9]N; (used for local calls) 
Telephone #:      9N 
Line/Group ID:  25 (this is the IP trunk connecting sites) 
Feature:              Dial 
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I NEED TO UPGRADE MY IP OFFICE 

SOFTWARE 
 

1. Download the software from HTTP://support.avaya.com or Jenne Distributors, 
Inc. (see Tech Services for download location) 

2. With release 3.2, there is no longer a need to remove the old software and install 
the new software.  Release 3.2 software will install on top of current 3.2 software.  
If you are still at any release prior to 3.2, you must remove and re-install the 
software. 

3. When you download the software, it will be in zipped format.  Create three (3) 
folders on your desktop for the software (Admin, User, and VM Pro).  Extract the 
zipped files to the appropriate folder. 

4. Install the new software via the setup program in each of the new folders you 
extracted the software to. 

5. Once the software is installed and you have rebooted your PC, launch the 
Manager application and pull an active configuration 

6. Once you are looking at an active configuration got to File > Advanced > 
Upgrade.  You should see your system with a current version and an available 
version.  Ensure the box for your control unit is selected as well as any expansion 
modules and select Upgrade.  Allow system to go through the upgrade process.  
After the IP Office is rebooted, pull a new configuration and click on Control 
Unit.  It should show the upgraded version of software. 

7. If you are upgrading from release 2.1 to 3.2, there are intermediate upgrades that 
need to take place.  Please contact Jenne Tech Services for this procedure. 

8. There have been instances where the upgrade process times out.  In this instance, 
we recommend utilizing the following procedure. 
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Setting up a Small Community Network between two IP Office systems 
 
 

Overview  
This document is intended as a brief guide to using VoIP 
VPN lines to link extension dialing between IP Office 
systems.  

With Small Community Networking enabled, the separate 
IP Office systems 'learn' each others extension numbers. 
This will allow extension calls between systems and support 
for a range of internal call features.  

 

NOTE 
In IP Office Software Level 1.3 and above, Small 
Community Networking supports a maximum of 500 
extensions across 16 IP Office systems. 

 
Requirements  

 A.  The documents assumes that you already have a 
working LAN or WAN link between the IP Office 
systems and that the link has been tested for correct 
data traffic routing.  

 B.  VCM modules are required in the remote and central 
systems.  

 C.  The extension and group numbering on both systems 
must be unique.  

 D.  The extension and group names on both systems must 
be unique.  
 • We also recommend that all names and numbers 

(groups, line, services, etc) on the separate IP 
Office systems are kept unique. This will reduce 
potential maintenance confusion.  

E.  All systems should use the same set of Telephony    
timeouts,    especially the Default Allocated Answer 
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Interval (System | Telephony).   The following is the 
process to set up a Small Community Network (SCN) 
between 2 IP Office systems via a LAN connection. 
 

1. There are basically two things that need to be configured for small community 
networking.  The same configurations are performed on both systems. 

 
A.  Create an IP Line by pulling an IP Office configuration and selecting line 
from the configuration tree.  In the area to the right of the configuration tree 
(where your current lines are listed) right click and select New. 

 

 
 

B. Next you have to specify the IP Trunk specifications as follows:  On the Line 
tab, specify the following as noted. 

 
 
 
 
 
 
 
 

Right click  
and Select 
New IP 
Line
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C.  Now click on the VoIP Tab, and fill in the following information.   

 

Give the IP trunk a Unique 
Line Number

Specify the lowest number of 
Voice Compression Modules 
between your systems. 

Specify your Incoming & Outgoing Group ID.  
Make it the same as your line number.  This is 
done for ease of programming as well as call 
routing over specific lines. 

In the Telephone Number 
field enter a description of 
the link, eg. "System B". 
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2. Now that you have created the IP Trunk, you have to create the IP Route.   

 
A.  Select IP Route in the Configuration Tree.  Once you select IP Route, you will have a 

default   IP Route with a destination of Remote Manager.  Right click below the default entry 
and select  New (as noted below).  

For the Gateway IP Address, put 
in the IP Address of the remote 
IP Office.  

Be sure to check Enable Faststart, and the most 
important thing, Voice Networking.  This enables 
the exchange of directory and user information 
between the IP Office systems and is the key 
enabler of Small Community Networking. 

Select OK 

Check that the H450 Support option is set to 

H450. This enable various Supplementary 

Signaling Services across the VoIP 

connection. QSIG can be used ifH450 is not 

Select the preferred Compression Mode. 
The same mode must be used by all 
VoIP lines and extensions within the 
network. 
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B.  When you select new, the following screen will appear.  Fill in the noted information 
as shown     below. 
 

 
 
 

 C.  Once you have completed the steps detailed above, reboot the IP Office.   
D. Now you are ready to perform the same programming procedures listed above for 

your remote IP Office. 
E. Upon completion of programming your remote IP Office, place a test call from Site 

“A” to Site “B”.  
 
Now that you have completed the configuration of the two IP Office systems, you have the 
following capabilities. 

A. Busy Lamp Field 
B. Camp-on 
C. Callback when free 
D. Paging 
E. Call Pickup 
F. Centralized voicemail 
G. Internal directory 
H. Absent text message 
I. Anti-Tromboning   

Right click and 
select new 

Gateway IP Address is the IP 
Address of your local IP Office 
Lan1 

Select Lan1 as the destination 

Select OK 
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I want to be able to monitor my VCM’s in IP Office 
 
 

In order to monitor the VCM’s (voice compression modules) in the following method, the 
IP Office system must be at R 3.1 or above. 
 

1. Launch the Monitor application by clicking on  and browsing to 
Programs > IP Office > Monitor. 

2. Go to File > Select unit in the menu bar.  A box will pop up and prompt you for 
an IP Address and Password.  Input the IP Address and Password of your IP 
Office and ensure that IP Office is selected on the right hand side under Control 
Unit Type and select OK. 

3. Within Monitor, click on Filters > Trace Options in the menu bar, this will bring 
up a box with several tabs. 

4. Click on the System tab and check the box labeled “Development Tracing”.  By 
clicking this box, you will now have a new tab added “VComp” and also be able 
to view your voice compression modules in Monitor. 

5. Go to Status in the menu bar and select Voice Compression.  This will bring up a 
box and you will be able to see vcm’s in use. 
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Outcalling (Callback) using VM Pro 
 

Voicemail callback is a service whereby the Voicemail Pro will call a specified number whenever the user 
receives a new voicemail message. When the callback is answer, the system announces the outbound alert 
and waits for a key press for confirmation before continuing with the associate call flow. 

To use this service requires configuration of a callback start point on the Voicemail Pro and entry of a 
callback number through IP Office Manager. 

Note: This feature is separate from voicemail ringback which alerts the user's own extension. 

  

1. Setting Up the Callback Call Flow for a user 

The call flow we have created below is a very simple example. In practice we could also include a menu 
that allows the user access to other features. For example access to a Play Configuration Menu action 
would allow the user to remotely change various mailbox settings including their callback number, see 
Using a Play Configuration Menu Action. 

  

 

1. Under  Specific Start Points, right-click on  Users and select Add. 

2. In the Name field enter the user's mailbox name. Select the Callback entry point and select OK. 

3. Within  select  Callback. 

4. Add a  Get Mail action and under the Specific tab, in Mailbox enter the user's name again or 
extension number. 

• IMPORTANT 
Record an entry prompt for the first action in the callback call flow.Experience with 
connection to some cell phone systems has revealed that this entry prompt may need to 
be up to 20 seconds in length. 

5. Connect the  Start Point and the  Get Mail action. 

6.   Save and make live. 
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The Default Callback Start Point 

In the example above we created a callback call flow for the individual users. The Default Callback start 
point can be used to create a default callback call flow for all users. 

If the Default Callback start point is used, it must be designed so that users have to indicate which mailbox 
they are accessing. In the simple call flow used above, this can be done by entering ? in the Mailbox field 
of the Get Mail action. 

  

2. Setting the User's Callback Number 

The callback number is initially set through IP Office Manager.  

1. In Manager, click on  to receive the system's configuration. 

2. Click on  User to display a list of existing users. 

3. Double-click on the user for whom callback is being setup. 

4. Select the Voicemail tab. 

• In Voicemail Code enter a pin code and confirm this in Confirm Voicemail Code. 

5. Select the Source Numbers tab. Right-click and select add to add a new number. 

• Callback Number 
Enter P followed by the destination telephone number. If you system requires an external 
dialing then that prefix must be included, for example P901923555456. If connecting to a 
cell phone or pager system that expects digits in separate sets, use , (comma) characters 
to add pauses to the telephone number dialing. 

• Trusted Source 
If calls from the callback number include ICLID, you can set that number as a trusted 
source. In that case no request for the user's voicemail code is made following the 
callback. Enter V followed by the CLI displayed on calls from the callback number, for 
example V01923555456. 

6. Click on OK. 

7. Click on  to send the configuration back to the IP Office. If the only changes made were to user 
settings, select Merge Config. 
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Using the Conditions Editor for Business Hours and Holidays 

 
 

Objective:   I want my VM Pro to send my incoming calls to one greeting during 
business hours.  Then I want it to redirect my incoming calls to an alternate greeting after 
business hours automatically. 
 
Solution:  The best solution is with a condition.  This will not only take care of Business 
Hours, but it can also take care of holidays as well.  The following instructions will only 
work for VM Pro. 

 
 

1. Click on the Conditions Editor icon. 

2. Click on the New Condition icon. 

3. In the Name field, enter condition name “Business Hours” and select OK. 

4. Click on the Elements icon, select Week Planner and click on the attendant Condition. 

5. Double-click on the Week Planner and tick Monday to Friday and your business hours and 
select OK.  

6. We need to changed the logic condition to an 'or' as working hours are Monday or Tuesday or … 
or Friday. Click on X+ and select X|| 'or'. Click on the Week Planner to change its logic setting to 
'or'. 

7. Now that we have created our condition, we need to put it into our callflow. 
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Now that we have created our callflow, we need to put it into our Automated Attendant. 
 

 

1. In the AutoAttend module, delete the connection from the  Start Point to the Menu 
action. 

2. From the Conditions Actions icon, add a Test Condition action and open its properties. 

• In the Specific tab, click on the list box, select the Attendant condition and select OK. 

3. Connect the Start Point to the Test Condition action. 

4. Connect the True result to the Menu action. 

A false condition would 
go to a leave mail or 
alternate Menu. 
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5. Save and make live. 

Assuming it is between 09:00 and 18:00 on a weekday (Monday to Friday), make a test call to the 
auto-attendant module. You should receive the normal attendant service. 

 
Now that we have input our Condition for our automated Attendant, we need to set up the system to 
recognize holidays.  This can be accomplished as follows.  Please see the programming procedure and an 
example callflow below. 
 

 

1. Click on the Conditions Editor icon. 

2. Click on the New Condition icon. 

3. In the Name field, enter Holidays and select OK. 

4. Click on the list of possible conditions and add a Calendar element to Holidays.  

5. Double-click on Calendar. Double-click on the current date, it should now appear similar to 

indicating it as a holiday. Click OK. 

6. Click on the list of possible conditions and add a Condition element to Attendant.  

7. Double-click on the Condition element and select Holidays. Click on OK.  

8. Click on the logic options and select a X! 'not' action. Click on the Condition to apply it.  

9. Our Attendant condition is now true when it is between 09:00 and 18:00, Monday to Friday and 
not a holiday. 

10. Click on OK. 

11. Save and make live. 

12. Make a test call to the auto-attendant. You should be asked to leave a message. 

13. Click on the Conditions Editor icon and in the Holidays Calendar element double-click on 

today's date so that it is no longer shown as . Click on OK. 

14. Save and make live. 
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Make a test call to the auto-attendant. You should hear the menu greeting. 
 

 
 
 

1. Start point goes to the Holiday test condition. 
2. True from Holiday goes to an alternate greeting or in the case above, a Leave Mail treatment.  This 

merely states that the specified day is a Holiday and route the call accordingly. 
3. False from Holiday goes to Work Week test condition.  This states that it is not a holiday, but is it 

within my normal business hours. 
4. True from the work Week condition states that it is during business hours and sends the call to the 

automated attendant. 
5. False from the Work Week condition states that it is outside of normal business hours and send the 

call to the Get Mail treatment for a general mailbox. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



   

This document Created by Jenne Distributors, Inc. Technical Services 20

 
 

 

I want to delay my Automated Attendant on IP Office with 
VM Pro 

 
 

Objective:  This document is intended as a brief outline for delaying your automated attendant.  This 
would allow for personnel to answer the phone before Voicemail Pro answers.   
 
Note:  This document does not cover all possible scenarios.  This job aid is being composed using IP 
Office R3.1.29.  This job aid will only work for VM Pro, not embedded or VM Lite. 
 
Requirements: 

 This document assumes you have a working knowledge of the IP Office Manager application and 
Voicemail Pro application. 

 Voicemail Pro license 
 Functioning automated attendant 

 
 
 Setting up the Manager application: 
 

 Pull a configuration for your IP Office. 
 Set your incoming call route to the desired Hunt Group as noted below. 

 

 
  

 
 Specify your Hunt 

Group Here 
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 Now you need to determine how long the phone should ring prior to the AA answering.  A 
good rule of thunmb is that every ring account for approx. 5 seconds.  This time can be 
adjusted in the Hunt Group form as shown below. 

 
 

 Now select the Voicemail Tab and ensure the Voicemail On box is checked as shown 
below. 

 
 

 Now you can “Merge” your configuration and continue on to the Voicemail Pro portion of 
configuring your system. 

 
Setting up the Voicemail Pro Application: 
 

Allocated Answer Interval determines 
the number of seconds a call will ring a 
Hunt Group before it goes to the AA.  
A blank entry indicates 15 seconds.   

It is important to 
note the name of 
the Hunt Group 
and the spelling.

Ensure this box is 
checked so that it will 
go to voicemail 
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 The first thing that you need to do is create a call flow for your Hunt Group (Main).  This is 
accomplished by Right-click on groups under Specific Start Points and selecting Add, as 
shown below. 

 
 

 Upon selecting add, you will be given the following box.  It is very important that the 
name is spelled the same as your hunt group in the Manager application.  
Otherwise, your call flow will not work and your AA will never get the call. 

Right-click and 
select add to create 
a call flow for you 
Hunt Group.
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 Left-click on the leave treatment and then left click in the large box where you Start Point 
is.  This will allow you to select the appropriate actions from the menu bar. 

 Left-click on the Basic Actions Icon and select the Goto action as shown below. 

 
 
 
 
 
 
 
 

 Double-click on you Goto action and left-click on the Specific tab.  Then click on the 

Browse button, .  At this point you will select you AA as noted below.   

It is very important that the 
Name field matches the 
name of you hunt group in 
Manager. 

Select “Leave” as your 
treatment for your Start 
Point 

Left-click the area next to Basic 
Actions and select Goto. 
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 Select OK twice and then connect your Start point to your goto action.  Click on Save & 
Make Live, and you are done. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

By default, Start point 
or module is selected 
by default

Hit the “Down arrow” and 
scroll down to Modules.  
Select your desired AA as 
noted. 
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Remote Retrieval of Voicemail using Embedded Voicemail 
For this section, we define Remote Mailbox Access as:  

• Accessing a mailbox from an extension that does not match the mailbox number.  

• External caller access to voicemail to collect messages from a mailbox.  

  

• WARNING 
Where remote access is setup for any mailbox, it is strongly recommended that a mailbox access 
code is set for every user and hunt group. 

  

Using a Short Code 

A short code using the Voicemail Collect feature but without a mailbox name specified in the Telephone 
Number field will trigger remote access.  

An example is show below. This short code could be utilized by users on the system, as the destination in 
an Incoming Call Route or as the destination for a auto attendant option.  

 
  

Using an Auto Attendant 

A short code similar to the example above can be entered as the Destination for one of the auto attendant 
Normal Transfer key options. See Auto Attendant Remote Access. 
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Using an Incoming Call Route 

The option Voicemail can be selected as the Destination and/or Night Service Destination of an 
Incoming Call Route.  

 
 

Auto Attendant Remote Access 
A useful function in auto attendants is to let callers access their own voicemail mailbox. This can be 
achieved by first creating a short code and using this short code as an auto attendant destination.  

1. In Manager, click and load the Small Office Edition system's configuration.  

2. For the user or hunt group for which you want to create remote access, open their settings and on 
the Voicemail tab ensure that a Voicemail Code has been set. Remote access will not work 
without this.  

3. Click Shortcode in the left-hand configuration tree panel.  

4. Right-click the list of existing short codes and select New. 

5. Create a short code such as the following example: 

 
6. Click OK to add the new short code.  

7. In the auto attendant, select the key that the caller should use. Set its Action to Transfer to 
Operator. Set the destination to *99.  

8. Click OK and use to send the configuration back to the Small Office Edition.  

9. External callers to the auto-attendant selecting that right option will now be challenged to enter the 
mailbox number and then the mailbox access code. Each should be followed by #. If entered 
correctly they will be able to collect messages.  
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Remote access to Voicemail using the Auto 
Attendant and VM Pro 

There may be occasions where you will want to access you own mailbox from a phone outside your 
companies phone system. Normally to do this your system will be configured with a special number you 
can dial in on and then select the mailbox required. However if this has not been done, the following 
methods can be used for remote access. 

 

Example 1:  
1. Call in to your company and ask to be connected to a number that will go to voicemail, ie. a 

number that will not be answered by a person. 

• Typically, ask to be connected to your own extension number. 

2. Wait for the voicemail system to respond and ask you to leave a message. After the tone, press # 
to complete message delivery. In some cases you may hear the prompt "No message to save". 

3. Dial *7. You will be asked to select the mailbox that you require. 

4. Enter your extension number and press #. 

5. Enter your mailbox password and press #. 

 

Example 2: 
1. Dial into your company main auto attendant.  Off that main AA have a silent option that performs 

a voicemail collect as noted below. 
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2. Within the Get Mail treatment, navigate to the “Specific” tab and select 
“Mailbox” with a mailbox of “?”.  This will prompt the caller for a mailbox and 
password.  An example is shown below.  

 
 

 
 
 
 
 
 
 

Silent transfer option to 
retrieve voicemail 
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Setting up a conference bridge with IP Office and 
VM Pro 

 
Objective:  Demonstrate the configuration of the Avaya Manager Application and Avaya 
VM Pro application to accomplish dialing into a conference bridge. 
 
Note:  This document assumes you have a working knowledge of the manager 
application and VM pro.  This documentation was created with IP Office R 3.1.56 
software and VM Pro 3.1.18 software. 
 

Example 1 
In this example callers are routed into conference 500.  

1. Using IP Office Manager, a new short code was created. This code allows callers to indicate the 
conference they want to join.  

• Short Code: 500 

• Telephone Number: 500 

• Feature: Conference Meet Me 

2. In Voicemail Pro, a new module called Conf500 was created.  

3. The following actions were then added to the module. 
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• The Check Digits action forces callers to match a PIN code.  

• The Assisted Transfer action contains the short code created above. This will place the 
caller into conference 500 in this example. 

 
4. External callers can be routed to the module by entering its name in an Incoming Call Route or 

making the module an option in an existing auto attendant call flow.  

 

 

Example 2 
In this example, callers are able to specify the conference they want to join.  

Forces a user to meet 
criteria in order to join 
the conference 

No choice or incorrect 
choice is directed to the 
operator 

Information correctly input will 
allow entry to the conference. 
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1. Using IP Office Manager, a new short code was created. This short code allows callers to indicate 
the conference they want to join. In this example conference 500.  

• Short Code: *91*N# 

• Telephone Number: N 

• Feature: Conference Meet Me 

2. In Voicemail Pro, a new module called Conference was created. 

3. The following actions were then added to the module.  

 

 
 
 
 
 
 
 

 
 
 
 
 
 
 

• The Check Digits action forces callers to match a PIN code.  

• The Menu action has been configured to expect 3 digits, indicated by the ???.  

• The Assisted Transfer action uses the short code created above.  $KEY part uses the 
digits the caller entered in the Menu action. 

Forces a user to meet 
criteria in order to join the 
conference

No choice or incorrect 
choice is directed to the 
operator 

The Menu allows a caller to 
input a conference of choice. The specific tab is directed to a 

short code that allows for user 
input of a specific conference. 
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4. External callers can be routed to the module by entering its name in an Incoming Call Route or 
making the module an option in an existing auto attendant call flow. 

  

5. Adding another short code to the IP Office system lets internal callers also access the call flow.  

• Short Code: *90 

• Telephone Number: "Conference" 

• Feature: Voicemail Collect 

 
Example Call flow 
 

 
 

This is the short code 
created in Manager. 
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As you can see in the above example, this is a basic call flow.  An option off  of the main 
AA is to “Goto” the conference module.  The call flow for the conference module  is 
shown earlier in this job aid. 
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I want to change greetings on my AA 
 

In this part of the exercise, we will add a short code that will allow you to access this start point from any 
extension.  

1. In the Manager program, add the following system short code: 

 

2. Save and merge the configuration to the IP Office. 
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3.  Within the specific tab of the edit playlist, you have to specify where the wav file is 
located and also have a file name.  Then all you would do is dial the SC and put in the pin 
and select the appropriate greeting to record. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Create a call flow called 
Recordings 

Create a Menu.  And 
add a Pin so only 
certain people can 
access 

From the 
Menu add 
an Edit 
Playlist 
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Using the for Dial by Extension and normal transfer 
 

 
 

Objective:  Demonstrate the configuration of the Avaya VM Pro application to utilize 
the same option from an AA for dial by extension and some other option, i.e. transfer to 
sales 
 
Note:  This document assumes you have a working knowledge VM pro.  This 
documentation was created with VM Pro 4.2.19 software.  In the example shown below, 
we will demonstrate how to use option “2” from the automated attendant to dial an 
extension and transfer to the Sales hunt group.  Typically, this configuration will be 
made for customers who have used a specific touch tone for a long time and are now 
migrating to VM Pro. 
 
 
1.The first step within VM Pro is to create your Menu as noted below. 
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2. Secondly, you are going to add a sub menu with a Timeout of 2 seconds and you 
will also add a Touch Tone of “??”.  This will allow you to use option 2 to 
transfer to Sales and also allow you to use 2 to dial our extension range of 2xx.  
The figure below is the end result of the sub menu configuration. 

 

 
 
3. The tricky part of this configuration is the “??” Since the caller has already 

pressed 2 from the main AA, you want that to carry through to be able to dial by 
extension.  You will make the following modification to the Transfer of “??”. 

 

 

Set the Destination field to 
2$KEY.  This will input the 
2 from the main AA and will 
wait for additional digits to 
transfer to an extension 
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4.  The final step is to connect you sub menu to the desired action.  In your case, you 
will be transferring to Sales and Extensions.  That is completed as noted below. 

 

 
 
 

5. When a call comes in and hits the AA, the caller selects 2 to dial either the Sales 
hunt group or input the extension they are trying to reach. 
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Using a User defined Variable in Voicemail Pro 
 

 
Objective:  Demonstrate the configuration of the Avaya VM Pro application to utilize a 
User defined Variable to use a temporary Automated Attendant greeting to account for 
staff meetings or other necessary closures. 
 
Note:  This example was extracted directly from Avaya’s knowledgebase.  The 
knowledgebase can be accessed at http://marketingtools.avaya.com/knowledgebase  
 

Using User Defined Variables 

In this exercise you learn how to add a variable that will be used to determine the 
call flow to be presented to the caller. This could be used, for example, when all staff 
are attending a meeting. 

  

a. Create a New Variable 

1. 
Click the User Defined Variable icon. The User defined variables window 
opens. 

2. Click the add icon. The Add user defined variable window opens. 

3. 
Enter Reception and click OK. The variable 'Reception' is added in the User 
defined variables window. 

4. Select Update. The User defined variables window closes. 
  

b. Create Modules to Alter the Variables Value 
In this part of the exercise, you create two modules – one for indicating when the 
reception is open, the other for when the reception is closed. When completed the 
call flow will look similar to the example shown. The items shown in red are the 
actions that will be added during this exercise. 
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1. Add a new Module called ReceptionOpen.
2. A new Set User Variable needs to be added. 

• Click Conditions Actions, click Set User Variable action.
• Click in the Details pane to place the action. 

• Open the Properties for the new Set User Variable action. 

• 
In the Entry Prompts tab, click Add a Prompt icon. The Wave Editor window 
opens. 

• 
The announcement message needs to be recorded. A suitable message would be 
similar to the following: "Reception is open." 

• Click the Specific tab. 
• Click the Assign the following user variable to select Reception. 
• In the with the following value field, type open. 
• Click OK. 

3. Connect the Start Point to the Set User Variable Action. 

4. 
Repeat the steps above to create a module called ReceptionClosed, where the 
value of Reception is set to closed and the prompt is "Reception is closed." 

5. Click the Save and Make Live icon. 
  

c. Add Short Codes to Change the Variable Value 

1. 
In IP Office Manager, add the following short 
codes: 

Field Enter: Enter: 

Code *91 *92 

Feature Voicemail 
Collect 

Voicemail Collect 

Telephone Number "ReceptionOpen" "ReceptionClosed" 

Line Group ID 0 0 
2. Merge the new short codes with the IP Office.
  

d. Using the Variable in the Call Flow 
In this part of the exercise, we will change the auto-attendant call flow according to 
the current setting of the user defined variable. When completed the call flow will 
look similar to the example shown. The items shown in red are the actions that will 
be added during this exercise. 
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1. 

In the AutoAttend module, delete the connection from the Test 

Condition's True result to the Menu action. 
2. A Test User Variable action needs to be added. 

• Click Conditions Actions, select Test User Variable.
• Click in the Details pane to place the action. 

• Open the Properties for the new Test User Variable. 

• 
In the Specific tab, from the This action will return TRUE if the following 
variable list box, select Reception. 

• In matches the value below, type open. 
• Click OK. 
3. The actions need to be connected. Click the Connection icon and connect: 

• The Test Condition's True result to the Test User Variable action. 

• The True result to the Menu action. 
• The False result to the Leave Mail Reception action. 

4. Click the Save and Make Live icon. 
• From any extension, dial *91 to set the reception variable to open.

5. 
Make a test call to the auto-attendant module. You should be played the 
attendant.wav as normal. 

6. From any extension, dial *92 to set the reception variable to closed. 

7. 
Make a test call to the auto-attendant module. You should be prompted to leave 
a message for reception. 

8. From any extension, dial *91 to return the reception variable to open. 
  

e. Combining the Controls 
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Two modules have been created, one to set the reception open, one to set the 
reception closed. To match those we created, two short codes also need to be 
created, so the list of modules and short codes continues to expand. With pre-
planning, we could have combined the two modules into a single module. An 
example is shown below. 

 

The current setting of reception is checked and the generic actions used to play, 
"Reception is open" or "Reception is closed". The Menu action then prompts, "Press 
1 to change or # to exit". 

If the user select change, the reception value is checked again and two Set Variable 
actions are used to change its value. The Home action then returns the user back to 
the start, where the new value is checked and the "Reception is open" or "Reception 
is closed" prompt is played. 

The reception may be using the SoftConsole application. If that were the case, rather 
than setting up a short code for this new module, one of the SoftConsole's speed dial 
buttons could be set to the number VM:ReceptionOpen. 

Thus by planning, we have reduced two modules and two short code down to one 
module and no short codes. 

 
 
  

 


